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Installation and Technical Information
Race Log File and Directories

Installed to directory

Race Log Program files
Fleet files, Archive file
Saved reports, Report Layout files

\Rlog
\Rlog\data
\Rlog\reports

____________________________________________________
ELB Software grants the purchaser the right to use one (1) copy of the Race Log software (“Software”) on a single
computer, and to make additional copies of the Software for backup purposes only. The Software is owned by ELB
Software and is protected by United States copyright laws and other applicable copyright laws. ELB Software warrants
that the Software will perform substantially in accordance with the accompanying documentation. ELB Software
disclaims all other warranties, express or implied, including but not limited to, any implied warranty of merchantability or
fitness for a particular purpose. In no Event will ELB Software be liable for any consequential or incidental damages
arising out of the use of or inability to use the Software. In no case shall ELB Software’s liability exceed the purchase
price paid by the purchaser for the Software.

_____________________________________________________
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INSTALLATION of Race Log system
Diskette
insert diskette into drive A
click Start | Run from the Windows Start Menu
type A:\SETUP and press Enter
you will be prompted to enter 2nd and 3rd diskettes
CD
insert CD into CD drive
click Start | Run from Windows Start Menu
type D:\SETUP and press Enter ( your CD drive letter may be something other than D )
The installation program assumes that you want to install on drive C:, and it creates the directory \RLog
(or a name you select) for the program and systems files. You may change these settings when asked
during the install process.

New Release History…
New in Release 1.2
1)

A new SORT dialog box for sorting up to 3 columns of data in a data window. The SORT capability
will sort by last name in the Name column based on which name option you select in the SORT dialog
box:
Option: "First Last" - first name followed by last name,
example: MaryAnn Smith
will sort by Smith
caution: Mary Ann Smith
will sort by Ann
"Last, First" - last name followed by first name separated by a comma,
example: Smith, Mary Ann will sort by Smith

2)

Improved SAVE capability for saving your scoring methods and scoring options.

3)

High Point Scoring method has been added, along with options to control how many points for first
place, DNS, DNF, and DSQ.

4)

Full TIE BREAKING has been added.

5)

Corrected errors in this documentation.

6)

Miscellaneous bug fixes have been incorporated into this release.

New in Release 2.0 & 2.1
1)

Corrected bugs in Tie Breaking, extensive testing has found it to be accurate

2)

Corrected various bugs

4)

Added Data Entry Dialog Box to increase ease of use for entering race results
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5)

Added Low-Point Averaged scoring method as described in US Sailing Association's "International
Yacht Racing Rules", Appendix B2

6)

Added additional documentation, and added documentation in Word and WordPerfect formats

7)

Multiple screen formats for providing the option of keeping track of additional data such as Sailing
Club or Country of origin. Multiple report formats to provide the option of printing all or a portion of
the data. Short report format for compact reporting handy for publishing results in magazines.

8)

Added Calculator and Calendar tools.

9)

Added ability to enter Override Points so you can control how many points a sailor receives in
special scoring situations.

10) Added option to set a Race Range when scoring: Score all races or Score selected races.
11) Added ability to create scoring subset from Standings list, ie. select top 10, top 20, etc.

New in Release 2.3
1)

Added ability to enter Race Dates, and print optionally print them

2)

Added ability to optionally print to a file, so report can be enhanced by a word processor or text
editor before publishing

3)

Fixed lock up problems

4) Added new Score Methods:
- High Point Average
- High Point Fixed
- High Point Fixed Average
st

nd

rd

5)

Added ability to include Bonus for 1 , 2 , and/or 3 in High Point Methods

6)

Ability to Include or Exclude DNS’s from scoring for High Point Methods, and ability to Include or
Exclude all Entrants when calculating DNS score for Low Methods.

New in Release 2.4
1)

Added TEAM Scoring.

New in Release 2.5
5/28/96
1)

Fixed problems with Class (subset scoring)

2)

Minor enhancements to data searching routines in the “Enter Finishes” dialog box.

3)

Minor corrections to documentation and Help files
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New in Release 2.6
11/24/96
1)

Addition of "Clear Finishes..." option in the FILE menu. This allows you to clear out the Finishes in a
fleet file and still keep the Sailor data. Useful for starting a new season with last years fleet file
without re-entering all the sailors.

2)

You can now Over-ride the Throwouts Percent with an actual number of Throwouts. The number of
races to Throw can be entered when you select "Score". This number over-rides the Throwout
Percent specified in the Scoring Options Setting screen for this "Scoring".

3)

The actual number of Races Scored after Throwouts is listed when you print the results. It's listed in
the heading information where all the Scoring Options are printed.

4)

The Report output width has been improved for printing to a File. The maximum is now 157. (The
minimum is still 60). A maximum of 157 allows for the widest printing results when using Windows 95
WordPad and setting the print orientation to "Landscape" with a font size of 8. ('Word Pad' allows
for Fixed size fonts which keeps everything lined up. Most Word Processors use proportional fonts
which causes alignment be off a little when printing the Race Log results unless you manually edit
the output.)

5)

Bug fix for scoring files with sailors who have no Finishes entered for them. Bug fix for erroneously
printing a column heading of "TEAM" instead of "CLASS".

New in Release 2.7
5/17/97
1)

Create Standings report in HTML format for inclusion on a Web site.

2)

Added “Bonus Point” scoring method - actually the same as previously supported “Olympic”
method.

3)

Upgraded support of DNC, DNS, DNF, OSC, RET, DSQ, and DND to the precise definition of each as
specified in the new 1997 Rules. Formerly a DNS was treated as a Did Not Compete, and a DNS was
the default Finish if nothing was entered for a race. Now a DNS means the racer showed up at the
starting area, but Did Not Start. A DNC is now the default entry for a racer who did not show up and
will automatically be filled in for non-competing yachts in a series.

4)

Extended the ability to specify whether the penalty is to be added to the number of Entrants, Starters,
or Finishers to all of the above penalty indicators.

5)

Expanded the “Class” and “Team” column to 3 characters.

6)

Added column for “State”, “Member”.

7)

Added ability to customize screen layout and report layout by selecting which columns to display, in
addition to the preset screen layouts already provided.

8)

Added ability to report the “Total Points” (score before removing Throwouts), in addition to the
“Score” for Low Point Method.
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9)

Added Conversion program to convert old Race Log fleet files to new format. This will occur
automatically when you open an old file. The old file will automatically be updated, and will not be
readable by your old Race Log release (Release 2.6 or older).

10) Added Race Results forms to installation files. Use for filling in
results on committee boat. RACEFORM is provided in .TXT format for
MS NotePad, .WRI format for MS Windows 95 WordPad, and .DOC for MS
Word 2.0 format.

Corrections and additions to the Release 2.7 release - 5/26/97
11) Corrected scoring problem - DNF was not calculated properly when penalty
is added to number of Starters. Fixed.
12) Corrected scoring problem - DND was improperly being "thrown out" when
calculating Throwouts. Fixed.
13) Customize Report Format - added option to select
Columnar "R_1 R_2 R_3 ...." format,
or Short "2-5-1-df-3-dc-dc-..." format
when building Report Format.
14) Added handy Forms to install disk (installed to your \rlog directory) for
entering Race Results.
"raceform.wri" - MS Windows 95 WordPad format
"raceform.doc" - MS Word 2.0 for Windows format
"raceform.txt" - MS Windows 3.1 NotePad format

Corrections and additions to Release 2.7 - 10/2/97
15) Added additional edit checking on new fleet File Names when using SaveAs to ensure a valid DOS
File Name. Prevents common problem of users entering long File Names, and File Names with spaces.
Long File Names and File Names with spaces are OK for Windows 95 32 bit applications, but not OK for
any DOS programs such as Race Log even when running under Windows 95. Also removed SaveOnto
from the File menu because it confused many users who should have used SaveAs. SaveOnto is used to
combine or concatenate two files. This function is still available on the Command Line.

Corrections and additions to Release 2.7 - 2/20/98
16) Sail Numb ers will now appear Right Justified in the display column instead of Left Justified, and will
Sort by Numeric Value. You may restore the Left Justification by editing the scr*.ini files and
remove the '(N)' on the 'Number' line.

New in Release 2.8 - 3/7/99
17) Simplify the install process for Windows 95, 98, NT users. Use of "InstallShield" for installing Race
Log on Windows 95, 98, NT computers. Automatically set up icons for execution from Windows Start
menu.
18) Allow installation under top level of directory structure, common in Windows, example - C:\Program
Files\Rlog. Formerly limited to only top level directory for RLog install directory.
19) Allow selection of up to three Divisions or Classes on "Select Class to Score..." menu option.
Formerly limited to two selections.
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New Enhancements in Basic Race Log Release 2.9 -- 06/01/00
- Renamed more menues for ease of use
- Stability enhancements
- Allow override of sailor who already has a finish when entering data using the "Enter Finishes" dialog
box. easier to recover from data entry errors
- New "Division" field in addition to "Class" field. you can keep track of a racer's Division and Class at
the same time. new selection screen to select Class or Division for fleet subset scoring.
- This release has new file format which will be compatible with the upcoming Registration Version of
Race Log. fleet files created with this release will work with the new Registration Version.
- Turn On/Off printing of Scoring Options at beginning of Score Reports
- Added ability to flag Throwout Races by printing with parentheses, (nn). You can turn this On or Off.
- Upgrade Reference Manual to Release 2.9 and added screen shots.

New in Race Log Regatta Registration Version Release 2.9
- New “Registration View” for entering complete Regatta Registration information for each sailor, plus
“Event View” for event specific information.
- Keep track of sailors: name, address, email, phone, local contact, payments, association status, age,
gender, class, division, boat name, and more including comments for free form information.
- Easily Search and Sort sailor data.
- Reports include multiple “Mailing Labels” , “Registration Lists”, “Scoring Sheets” (with racer data)
- Complete integration with Basic Race Log - automatically invoke the “Racing View” with opened fleet file
for entering scoring information, then return to “Registration View”.
- Upgrade Reference Manual to Registration Version - Release 2.9 and added screen shots.

New in Race Log 3.0
- Complete re-write of the “Racing View” Race Log for Windows
- Many ease-of-use enhancements
easier navigation among the many Race Log options
single screen for selecting Score Method and associated bonus points, penalty options, etc
improved method of changing screen format (full control over which fields appear on screen and
report)
keep track of finishes you enter when using the Enter Finishes dialog box
correct results by inserting a penalty or corrected Finish – Race Log will automatically figure out
how to re-sequence results
change Font type, Font color, and Font size of screen
- Improved printing
three print options – Direct to Printer, HTML Format, WordPad format
control over Font type and size – useful for printing large fleets
- Automatic upload of results to internet – hosted at Race Log website
free hosting of results at Race Log website
anyone can upload at click of a button – no need to wait on your computer guru to help with
uploads

New in Race Log 3.1
- Find function in Registration View is now Case Insensitive
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- Added more fields on Registration View grid to provide more ability to Sort data by fields such as Age,
Measured, etc.
- Added new Report to print out and summarize Payment information in Registration View.
- More intelligence while Re-sequencing when Inserting Penalties in Racing View
- Added “Red” color error messages while entering data in “Enter Finishes” dialog box in Racing View
- Added ability to Sort data by clicking on Column Heading is Racing View
- Added visual queue that Column heading is active when mouse passes over the Column Heading in the
Racing View.
- Throwout “earlier” finish or penalty when throwing out duplicate finish or penalty (previous versions
threw out “last).

New in Race Log 3.2
- Completed support of new Racing Rules 2000-2004: 1) new Penalty codes, 2) Tie breaking, 3) Scoring
Penalty
- Fleet files with the old Penalty codes will still work, they will be interpreted and printed out as the New
codes.
- Added more intelligence to Re-sequencing done by Race Log when using the “Insert Penalty/Finish”
dialog box, plus support for new Rules
- Added more intelligence to “Enter Finishes” dialog box to allow for entering a penalty, then continue
with next finish without Race Log getting lost, added “Reset” buttons to make it easy to find the next
Race to enter, and to find the next Finish to enter for any selected Race
- Significant performance improvements: 1) when loading the Registration View, and 2) when scoring (90
seconds down to 2 seconds for large fleet file).

New in Race Log 3.3
- Fixed a bug to conform to US Sailing's interpretation of tie breaking rules for situations where multiple
boats are tied, rule A8.1 does not break the tie, rule A8.2 breaks the ties of two pairs, however A8.2 does
not break the tie of the singles in the pairs, and rule A8.3 must be applied to the singles instead of rule
A8.2.
- Added "Drag 'n Drop" method of entering finishes. Simple drag each racer to the finish list as in order
of finish. Can re-sequence by dragging finisher to different spot in finish list. Can change finish to a
Penalty with a click of the mouse, and re-sequencing of the finish list is done automatically.
- Added ability to create Customized registration report. Specify which fields by dragging Fields to
Layout area. Automatically switch between Landscape and Portrait mode depending on how wide the
layout is. Modify Field widths, specify Sort field, rearrange layout with mouse drag. Layouts can be
Saved and reused or modified.
- Added ability to Archive fleet data from your fleet files. Archive can be added to, can be selected from
to create new files, or add onto existing fleet files. Extensive ability to specify Selection Criteria to
determine which records to Add to Archive, and which records to Extract from Archive.
- Added support for the new ISAF ID created by the International Sailing Federation. Sailor's name
becomes a link to biographical data. See - www.sailing.org - for more information.
- Added ability to select and create a UserID from within Race Log. Formerly the user had to go to the
Race Log website first, and then request the UserID when ordering the product. UserID's are used to
establish a folder at the Race Log website for "one-click" uploading of race results to the internet -results available at ....
http://www.racelog.com/results/youruserid

New in Race Log 3.4
- Stability enhancements
- Usability enhancements - more buttons on menu bar, easier access to Race Log functions
- Display currently selected Score Method on button bar
- Throwouts can now be used for High Point scoring methods (High Point, High Point Average, High
Point Fixed, High Point Fixed Average)
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- Improved appearance of results reports -- optionally add shading to every other listed sailor ( for
Web format, and Direct to Printer format), and option to print borders on Web format
- Improved control over report width
- Updated tie breaking now in Shareware version (previously only in Pro version)
- More “fixed width” Fonts available for printing reports, and for screen display

New in Race Log 3.4, Build 5
−
−
−
−

Squares of 40 Method (used by Snipes). This is similar to High Point Fixed Averaged
Added ability to capture existing UserID. Previously could only Create a UserID. If
you reinstall Race Log and loxe the connection to your UserID, then this will allow you to
reconnect to it
Fixed occasional lost record bug.

New in Race Log 3.5, Build 6 (2/11/06)
- Added ability to "Use" a UserID which is already established on the Race Log website.
- this capability is coordinated with the new ability to "create" a new UserID
at the Race Log website.http://www.racelog.com/results/rlogt_choose.htm, and then
capture it in Race Log via the "UserID" menu selection (Registration View, or
Racing View).
- Easier access to the "Upload" function from a button on the Menu Bar in Racing View.
You can open existing reports and upload directly without requiring that a "Fleet"
file be opened.
- Shareware version now supports 3 userids, the Pro version 15 userids.
- The Pro version now supports "On-line" Regatta resgistration with optional
payment accepted with Paypal. (Not available in Shareware Version because a small
level of support is required to get Paypal set up.)
- On-line registered sailor data is downloaded directly into Race Log "Registration
View" saving lots of data entry time at regatta check-in.

New in Race Log 3.5, Build 9
−

Added ablity to Import external data into Race Log fleet file format. Added ability to

New in Race Log 3.5, Build 11
−
−
−

Completed all Online Registration capabilities including complete Paypal integration and setup,
and ability to easily customize Online Registration Form, and automatic upload of Form to
internet.
Network Fleet Files - Added ability to Open/Save/Share fleet files on internet
Add ability to save the Import Map defined in the import external file process. The map can be
reused.

** Call ELB Software if you are interested in setting up On-line registration.
for any of your regattas.
(847) 746-4515
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Race Log Startup
Windows (95, 98, ME, NT, 2000, XP) users click the Start menu and then select “Race Log ” from the Race
Log menu entry. Below is the first screen you will see…

Click the “Registration View” or the “Racing View” button to enter the Race Log product.

Registration View
The Registration View is for entering, viewing and reporting on regatta or fleet data. Use this view to
regis ter a new fleet for a regatta. From the Registration View you can go to the Racing View for the fleet
file you are processing. You can also access your Race Log “Archive” file from the Registration View.

Racing View
You can enter the Racing View directly from the screen above if you are mainly interested in entering
“Finish” data and scoring. The Racing View also lets you create new fleet files and add/change/delete
racers in the fleet file. The personal data types of fields such as address, phone, email and such are not
viewable in the Racing View.
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Regetta Registration
This feature allows users to enter all regatta registration, or seasonal fleet data into Race Log screens on
PC, or to download data into Race Log from On-line Regatta Registration process. First the PC data entry
screens will be reviewed. The downloaded data will automatically be formatted to the same fields on the
following screens. An external data Import process can also be used to fill in the data represented in the
following screens. This data can be saved in a fleet Archive which allows sailor data be saved and
accumulated from season to season. The fleet files managed here can also be saved on the internet as a
Network Fleet File for sharing among dispersed race managers.

Sailor Data
Enter as much or as little sailor data as need to manage your fleet or regatta.
Select “Fleet” | “Create New Fleet” or “Open Existing Fleet” from the menu, or click one of the buttons
on the button bar…

The “Open Archive Fleet File” option above will open the Archive file and display all sailor data in the
Archive. See the “Archive” section for more information.

Enter the sailor data, then click the “New” button in the Record area of the screen to enter another, and so
on…
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Each Button on the above screen has built-in Pop-up-Hints. Just hold the cursor over any button for a
couple of seconds and a pop-up Hint will explain its function.
Navigation - Click the “Next” or “Prior” button in the Record area to scroll through the data. The multiline scroll area above the data entry area of the screen is there to help you visually see where you are in
the fleet data. You can also use the Scroll Bar there to scroll through the fleet data.
Searching – type in the data you wish to search for into the entry box next to the “Search” button, then
select the “Field” from the next box, and click the “Search” button. Race Log will scroll to the next record
containing the data. Click “Search Again” to find the next, and so on. The search is Case sensitive, so
“Smith” and “smith” are different.
Sorting - Sort the fleet data by clicking on any of the Column Headings. Clicking on the “Name” Column
will sort by the data as it appears in the column – ie. by First Name if you have typed the name in “First
Last” format. Clicking the “A-Z” button on the right side of the screen will sort by Last Name even
though the name is in “First Last” format. Or you can enter the name as “Last, First”. In this case clicking
on the “Name” column heading will sort by Last Name.
Age - The “Set Age” button will calculate and set the Age field based on the “Date of Birth” field. The
appropriate Class field will also be set based on the calculated Age. (This is currently set for the Optimist
Class.)

Event Data
Select “View” | “Event Information” to enter data pertaining to your event…
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Event Information screen
You can switch between views from the “View” menu. Enter as much or as little data as needed. There
are no required fields. This data is saved in the fleet file you are actively viewing.
Race Results – Click “Go Race” from the “View” menu, or the “Race” button on the button bar to go to
the Racing View. The Racing View of Race Log will open with the fleet file you have been working on.
Go to the Race Log documentation below for instructions on entering finishes and scoring races.
Important note regarding fleet files - When you exit the Racing View after you finish scoring, you will be
returned to the Registration View of the same fleet file. The fleet data for each of the Views –
Registration, Event, and Racing, is in a single fleet file. Each View shows you the pertinent data from the
file for that View. So you can go straight to the Racing View of Race Log and open your fleet file if you
have no more Registration data to enter.

Reports
Clicking the “Reports” button or using the “Reports” menu will display the following window where you
select which Registration report to create.
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Mailing Labels - “Labels 3 Col” button generates an Avery # 8160 compatible report (3 column labels).
The data will be in the most recent sort order you specified in the Registration View.
Mailing Labels – “Labels 2 Col” button generates an Avery # 8161 compatible report (2 column labels).
The data will be in the most recent sort order you specified in the Registration View.
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Forms for the Race Committee to use in compiling Finishes…
Racing Form – “Racing Form A” button generates a racing form as below with racers listed based on
most recent sort order specified in the Registration View.
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Racing Form – “Racing Form B” button generates a racing form to fill in boats as the cross the finish line.
The racer data on the left side of the form is your legend to find the sailors Name and Sail Number. The
data is automatically sorted by Sail Number for easy identification of boats as they cross the finish line.
A “Compact” version of this report is also available from the menu which allows more sailors per page on
the legend, and more entries down the right side of the page for finishes.

Fleet Detail – Complete list of fleet data. You can sortany of the reports by sorting the data prior to
selecting the report. Sort by clicking the column heading.
Quick List – Lists Name, Address, Country, Sailing club, Sailnumber, and Class.
Essential List – Lists Name, Sailnumber, Date of Birth, status of Medical Form, Waiver Form, Association
Membership, Measured, and Amount Due.
Payment Summary – Lists Name, Sailnumber, Amounts paid, and Amount Due, with Totals at the end.
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Custom Report – Clicking the “Custom” button on the Reports screen will display the window below
where you may define your own report layout.
Use the mouse to drag Fields from the field list to the Layout area. A “Left Mouse button” click over the
Field column heading will allow you to 1) change the length of the field displayed on the report (shorten
from the default field length), b) select the Sort field for the report, and c) view the Field name of the field
in the layout.
You can re-arrange the fields by moving the field column heading with the mouse.
Add a title to the report in the “Report Title” entry field.
The layout can be saved and re-opened via the “File” menu selection.

Create a report layout by dragging fields to the Report layout area above.
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Archive Fleet File
The Race Log Archive file is accessible from the Registration View. The purpose of the Archive file is to
save fleet registration data for re-use. For example if you host multiple regattas during the season, you
can save all of the registration data from each regatta into the Archive file. All of the fleet data is then
available for next year’s regattas. You can use the Mailing label reports to send invitations without reentering the data again. You can use the Extract feature to pull out only the sailors you are interested in
to create a new fleet file for your next regatta.

.Archive menu item.

Opening the Archive
Select “Open Archive Fleet File” from the Fleet menu to open your Archive. An Archive file is simply
another fleet file and will be displayed just as any other fleet file. There will be no “Finish” data stored in
the Archive. All other previously entered data will be available. The Finish data is stripped when the
records are added to the Archive.
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Registration View data screen – fleet data, or Archive data.

Extract from the Archive
Specify your selection criteria as below, to indicate which records you want to pull out of the Archive file.
You can then create a new fleet file with the selected data, or add the data to an existing fleet file. Use the
“New File” button on the Selected Records screen below to create a new fleet file – you will be prompted
for a new filename. Use the “Add” button to add the selected records to the end of an existing file – you
will be prompted for a filename.
Selecting records – The following screens show how to specify selection criteria

Extract and Selection Criteria menu item.

Specify Selection Criteria screen.
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The screen above will allow you to specify which records to pull out of the Archive. As an example you
may wish to extract only records where “DIV” (Division field) is “SUN” as in Sunfish. This assumes you
use the Division field to indicate what boat is being raced. Any field in your fleet data can be used in the
selection process.
An additional field is available to simplify the selection process – the “Sel” (Selected) field. This field
contains either a “Y” ( for Yes, select this record) or “N” (for No, don’t select this record). You can
specify this by mouse clicking the following checkbox
next to the “Name” field on the
Registration screen. There is also a shortcut button “Select All” and “UnSelect All” for setting the
whole Archive to all “Y’s” or all “N’s”. You can then use this field in your Selection Criteria.
For multiple field selection criteria the “AND” tells Race Log to select records which meet each of your
criteria – such as select records which have both Div = SUN AND Gender= F for all female Sunfish sailors.
“OR” tells Race Log to select records which meet any one of your criteria – such as Div=WHT OR
Div=BLU to obtain records which are have either WHT or BLU in the Division field.

Selected Records screen.
The above screen displays the records selected from the open fleet or Archive file. You can remove any
record from the above list by selecting the record, and then clicking the “Remove Record” button. The
record will be removed from the Selection list, but not deleted from your fleet file.

Adding to the Archive
Open a fleet file, then use the “Selection Criteria” as shown above to specify which records you want to
add to the Archive. Click the “Archive ” button on the Selected Records screen to add the records to the
Archive. The Finish data will be stripped as the records are added to the Archive, however the original
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fleet file will not be changed. You can also remove records from the selection list as described above in
“Extracting from the Archive”.
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Import External Data
External data can be imported into Race Log, allowing data from Spreadsheets, Access databases, flat
files, other scoring programs and more to be used with Race Log.
The Race Log fleet file is a fixed format file with fields in fixed locations in the record, and with a header
record as the first record in the file. The Race Finish data is a variably occurring fixed field at the end of
each record. The import function converts a delimited file to this format.
The data to import must be a delimited file with a fixed number of fields in each record. Some of the fields
may have no data but it must indicate it’s presence with adjacent delimiters. You can specify what the
delimiter is in the Import Dialog screens in Race Log (see below). The file format can be a CSV file which
meets the import format criteria. CSV files are usually created in a spreadsheet program such as Excel. A
CSV file has fields which are delimited by Commas, and has quotes around some of the fields (usually text
fields). Or the file can be delimited by any delimiter with or without quotes around the fields. Race Log
also asks you whether the file has a header record ( first record in file is a descriptor record which has field
names, no data). The following screens show the “Delimiter Selection” and the “Drag and Drop” screen
where the import field map is specified.
Imported files can be anywhere on your computer, but Race Log has a “Download” directory where these
files can be stored before going through the import process. This makes for easy management of import
files. The “converted” file is then saved in the “Data” directory where you normally find Race Log fleet
files.
Once the file is converted it can opened like any other fleet file in the Registration View or Racing View
screens.
Since there are a variable number of Race Finishes in a Race Log file, you can specify how many Races to
import from the import file. Some import files may have only Registration data for example and no finishes.
So in this case you would select “0” races to import. The number of Races selected for import has no
effect on entering finish data later in the Racing View of Race Log. You can import 5 races for example
because that may be all that exists on the import file. However you can then enter as many additional race
finishes as necessary later in Race Log.

Above – Select 1) Delimiter, 2) are Quotes used to contain fields (does not have to be all fields, just some fields – then
select “Has Quotes”, 3) is there a header record
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Above – Drag fields in the “From” column to the appropriate field in the Race Log (the “To” column)

The Import dialog screen shows the data in the import (“From”) file so you can easily identify what fields
you are importing, and then drag to the appropriate Race Log field. You can scroll through the data to
help in the field identification process. If the file does not have a header record then this will be your only
guide to what you are importing.
Each field in the “From” column is also identified with a generated Field Number. You can drag a field in
the “From” column even though it has no data, only a Field Number.
If you make a mistake and drag to the wrong “To” field, then use the “Right Mouse” button to click over
the dragged item you want to remove. A popup menu will give you the opportunity to Remove the
dragged item.
Once you have “dragged and dropped” you import map, the select the “Convert” menu item to convert
the file and save it into the Race Log “Data” directory with the rest of your fleet files.
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The Map defined by the drag-n-drop process can be saved to a Map file. The Map can then be re-used
by opening the saved map file which will automatically fill in the right side column of the above screen.
Map files are saved in the \Rlog\Map directory.
Restrictions:
• Import file must have same number of fields in each record, empty fields are OK as long as they
are indicated by adjacent delimiters.
• Quoted fields can have a delimiter within the field – ex. “Smith, Ralph” – if “comma” is used as
the delimiter then the comma in the example field is part of the field and not treated as a delimiter.
No “escaped” delimiters, or “escaped” quotes are allowed in the file. In other words if the file has Quotes
around fields, then a “ cannot be contained inside the field.
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Online Registration
(requires Pro Version)
For Up-to-Date information about this new feature, go to Race Log website www.racelog.com
The following menu from the Registration View of Race Log provides access to all the Online Registration
capabilities.

Your “RegisterID” is required for the setup of Online Registration and is assigned by ELB Software.
Registered users send your request to elb@racelog.com.
You can extend the Registration capabilities of Race Log to allow online registration for regattas. You can
provide a link from your website to the following URL where sailors will go to register online for your
regatta – http://www.racelog.com/register/RegisterID. Instructions are clearly provided in the process to
guide users to payment by optional Paypal, or payment by Check with mail-in instructions. This requires
that you set up a “Merchant” Paypal account which is hooked up to your club’s bank account. You will
need your “RegistrationID” assigned by ELB Software to set up the website referred to above. This is
similar in concept (although a different ID) to the UserID for uploading results to the internet. Receipts
are generated for the user to print out to provide verification of registration. Also Paypal generates an
email receipt for the user, and an email notification of payment to the email used to setup your Paypal
account. If optional online Paypal payment is not selected then that sailor’s payment fee will be denoted
in the fleet file as a negative number indicating Amount Due instead of Amount Paid.
The registration data is downloaded by the Race Log user directly into Race Log. This is done with the
“OnlineReg” menu above and selecting “DownLoad Registration Data…” in the Registration View of
Race Log. The data can be downloaded at any time, even before all registrants are completed. You can
manage the on-going flow of registrants to see how many to expect for you regatta. This saves a lot of
data entry time at regatta check in since the sailors data is already in Race Log format, ready to score.
Once the data is downloaded into Race Log then all the Registration View functions outlined in the
previous section are available for this new fleet file.
You can manage, view, and download online registration data into other file formats than Race Log from
the “Admin” section of the website files you generate. You can access this screen at
http://www.racelog.com/register/RegisterID/admin.htm This is not a publicly visible web address, so
provide it only to those who need access to it.
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________________________________________________________________________________
___
The above screen is the Admin screen for managing online registration data.

Setup Online Registration and Paypal

Walk through steps on screen for setting up online registration.

Step 1
Paypal setup for RaceLog Online Registration:
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If you plan to have sailors pay by check only (no Paypal) and mail it in, then you can proceed to Step 3.
Other go the the Paypal website – www.paypal.com and follow the instructions below. Each step must be
carefully set up as specified in order for the whole process to work correctly.
You must have your “RegisterID” assigned to you by ELB Software before completing the following
Paypal registration. Send a request to ELB Sofware – elb@racelog.com (Pro Version only)
Go to www.paypla.com
Setup a PayPal “Merchant” account – there are several types –
− select “PayPal Website Payments Standard”
− setup Bank Account, Email verification, etc.
Go to “MyAccount”
Go to “Profile”
‘Financial Information’
‘Bank Accounts’
Verify Bank account information
Go to “Selling Preferences”
“Instant payment Notification Preferences”
Turn ON
Enter URL – http://www.racelog.com/register/RegisterID/resend.php
Go to “Selling Preferences”
“Website payment Preferences”
Auto Return - ON
Return URL – http://www.racelog.com/register/RegisterID/receipt.php
Payment Data Transfer – ON
When you click “Save”, an Identity Token is created, and you must go back into
“Website Payment Preferences” to retrieve it…
Copy it and paste it into an email. Send to yourself for save keeping ,
and enter (Paste it) into the Online Registration Setup screen in Race
Log.

Step 2
Enter the Email you used to register your account at Paypal
Enter the Registration ID assigned to you by ELB Software.
Enter the Identity Token created during the Paypal registration process.

Step 3
Enter your Regatta Name and Mailing Address for mailing in the registration fee paid by check.
Then UpLoad the automatically generated HTML files to support your online registration process.

Step 4
Customize your online registration form. This generates the customized HTML form, allows you to
Preview it. And then Upload it to the internet. This automatically puts the form into your Registration ID
folder and is available to your registrants at http://www.racelog.com/register/RegistratiionID.
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Customize your online registration form, then Preview, and Upload it.
The following items are customizable as shown on the above screen. Basically anywhere you can enter
data is a customizable entity...
Regatta Name – enter the name of your regatta to appear on registration screens
Regatta Dates (one line of text, ex. Aug 1 – Aug 4, 2006)
Hull Types – allows form to ask user which fleet he will sail in, ex “Sunfish”, “Laser”. The fleets
can be managed in one fleet file by Race Log, or separated into separate fleet files by Race Log
after downloading to Race Log on your PC. If “Show Hull Types” is not checked then this
option will not appear on the online registration form.
Age or Birthdate – allow users to enter Age or Birthdate on the online registration form. If
Birthdate is entered then Race Log will automatically calculate Age which will appear on the
registration form after downloading to Race Log
Due Date – optional date will appear on form
Regatta Fee – enter the fee for the regatta in the dollar amount field
Comments – explanation which will appear on the online registration form
Sailor Meals – any text can appear here to describe additional fees, along with dollar amount in
the next field
Allow Qty – check if you want the user to select how many of this item he is ordering. The price
will be calculated automatically based on the price entered in the previous box.
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Comments – explanation which will appear on the online registration form
Guest Meals – use same as above “Sailor Meals” line for any additional fee item.
Note – both “Sailor Meals” and “Guest Meals” entries are optional. If there is no
addition fee other than the “Regatta Fee” then leave these fields blank and nothing will
be generated.
Regatta Address – Optional Comment field will appear on bottom of generated form
Comments.. – Optional Comment field will appear on bottom of generated form.
The form can be Previewed, and then saved. You can save multiple versions of your form for testing, for
multiple regattas, and for re-use.

Download Registered Sailors

Download registered sailors into Race Log
The download process creates at “download” file which you can save into the “download” directory in
the Race Log installation. You can keep several versions of your download file. Then use the “Convert”
function to convert the downloaded file to Race Log format and save it in the “data” directory where your
fleet files are stored.
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Network Fleet Files
(requires Pro Version)

Fleet files can be stored on the internet and shared among geographically dispersed race managers. This
saves the effort of copying and emailing fleet files between users who need to pass the processing of a
fleet file to multiple people. Fleet files can be uploaded from Race Log, and downloaded to Race Log from
a Open/Save Fleet Files menu selection in either the Registration View of Race Log or the Racing View of
Race Log. A button on the menu bar also accesses this function.
This features requires that you be assigned a NetFileID which is a folder on the Race Log website where
you files will be stored. This is not a visible part of the website, and the NetFileID must be assigned to
you by ELB Software. Registered users can send a request for a NetFileID to ELB Software at
elb@racelog.com. Multiple network file ID’s are available.
Enter your NetFileID in the form below. The ID is saved automatically and will appear on your next use of
Race Log.
Click on the folder below next to the “Network File List” to display a list of files saved on the network
under your ID. Select the file you want to download, then click the Download button. You can specify
where the file is saved on your PC and what filename to use. The default directory is the RaceLog\Data
directory where all your fleet files are saved by Race Log. In order to manage your downloaded files more
intelligently you may want to use a specific file extension when you name these files – such as “.nff” for
Network Fleet File.
Click on the folder next to the “File to Upload” entry field to select which file you want to upload or
“save” back to the network location.

Enter NetfileID, list Network Files, and select fleet file to upload
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The Network Fleet File capability can also be used to store your fleet files from season to season
(including your Race Log Archive file). These files can easily get lost as scoring responsibility passes
from person to person each year.
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Entering Race Results in Racing View
Quick Start for New Race Log Users
•
•
•
•
•
•

Open an existing file of fleet data using the "Fleet" | "Open Existing Fleet" menu option, or create a
new file using the "Fleet" | "New Fleet" menu option.
Enter your sailor's Name and/or Sail Number along with their Finishes in the appropriate Race column
on the screen, or select the “Edit” | “Enter Finishes…” menu option and Race Log will prompt you
for each finish starting with the First finisher.
Before you score the results you need to select your scoring method (such as Low Point) and scoring
options (such as throwouts). Select the “Options” | “Score Method”, or “Scoring” | “Score
Method” menu selection and fill in the appropriate information
Select "Score It" from the "Scoring" menu. Your fleet will be scored and standings will be displayed
on the screen.
Print the results by selecting "Print" from the “Fleet” menu. That's it!
Race Log automatically computes your scores including all Penalties, Tie breaking, and automatically
computes Throwouts (including not throwing out a DND).

Data Entry Overview
The Race Log system works similar to a word processor or spreadsheet system in that your data can be
entered in a full screen edit mode. Use the Home key to move the cursor between the Command Line and
the Data area. There is no particular order of entry required - partial names or Sail numbers can be entered
and updated later; finishes can be modified at any time; records can be deleted or added at any point in
your data entry process. Save your fleet data using the “Fleet” pulldown menu, or type the “save”
command on the Command Line. You will be asked to save if you try to quit but forgot to save your data.
The Race column is where you enter a racer’s Finishing position, or DNC, DSQ, DNF, etc.. Actual points
earned by the racer are automatically calculated by Race Log. ( Occasionally it is necessary to override
the actual points a sailor earns for his finish. This situation can occur if you have a protest and need to
adjust scores, or if you provide series credit for sailing in out of town regattas. For information on
Override Points see the Override Points section.)
Again, similar to a word processor or spreadsheet, you can edit an existing file containing race results, or
you can create a new file, and you can have more than one file open at the same time which is handy for
comparing to a previous year's data. Open an existing score file or create a new one by making the
appropriate selection from the “Fleet” pulldown menu.
Race results can also be entered using the “Enter Finishes” dialog box on the “Racers” pulldown menu.
This will prompt you for the next finish in the next race. All you do is enter the Name or Sail number of the
racer.
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Data Entry Specifics - Full Screen
Enter racing data by typing in the data screen under the appropriate columns.

The Home key will move the cursor back and forth between the Command line (where you can enter
commands) and the Data area of the screen (where you can enter and edit data).
After entering the sailors Names or Sail Numbers you may want to Sort the list of names by last name (see
the SORT dialog box in the Edit pulldown menu) or by Sail Number so that you can more easily find the
sailor you are entering results for. Make sure you Save your fleet data to keep it in your Sorted order.
The mouse can be used to place the cursor anywhere on the screen where you need to enter or change
data.
The data can be Sorted by mouse clicking any Column Heading.
The Tab key will move the cursor to the next column, Shift/Tab will move to the previous column.
The Arrow keys will move the cursor around the screen.
The Enter key is a little different than a word processor, it will take you to the next line but it does not
insert data onto the following line like a word processor. It will, however, create a new record (new line) if
you hit the Enter key while on the last record in the file. Also the Enter key will remember where you
started typing on a line and position you on the next line underneath where you started typing. This is
handy for entering multiple finishes for a particular race since Enter will keep you in the same Race
column.
The Insert, Delete, and Backspace keys work as you expect them in a word processor.
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The “Insert Racer ” and “Delete Racer” entries on the “Edit” pull-down menu will insert or delete a line
(or record). First, place the cursor on the line you want to delete, or place the cursor on the line where you
want to insert a new record and then select the “Insert Racer” or “Delete Racer” option. (Also see
Keyboard below: F2, Ctl+F2, and Ctl+Del.)
Insert and Overtype mode when typing. You can tell what mode you are in by the size of the cursor. If
the cursor is an underline then you are in insert mode. If the cursor is block shaped then you are in
overtype mode. You can change between Insert and Overtype mode by pressing the Insert Key.
When entering finishes in the Race columns the system will always automatically overtype what was in
that column whether you are in Insert or Overtype mode. The Insert and Overtype modes act in a more
normal word processor fashion in the other data columns - such as Name, Class and Number (sail number)
.
Any Race column left blank will automatically be scored as DNC. This will also happen if a 0 or bad data
is entered in a Race column. You only need to fill in the finishes for those who actually started a race, this
includes DSQ and DNF - these must be entered. DNC may be entered if you chose.

Race Dates
Dates will appear on the first line under the column heading. If the Race Date line is not there, select “Add
Race Dates” from the “Edit” pulldown menu. Then use the mouse to click under the column heading for
a specific race. A dialog box will open for you to enter a date. The following formats may be used to enter
a date: mm-dd-yy, mm/dd/yy, mmddyy. (Examples: 012996, 1/29/96, 1-29-96).

37

Data Entry Specifics - “Enter Finishes” with Dialog Box
Select the "Enter Finishes by Place" dialog box from the "Edit" pulldown menu.

How to use the “Enter Finishes” Dialog Box…
1 – Race Log will automatically determine the current Race to score:
• Race Log positions you at the next Race to enter (RC_9, RC10, etc)
• Race Log prompts you for the next Finish to enter (1st, 2nd, etc)
2 – For each Finish you wish to enter type the racer's…
• First Name and/or
• Last Name and/or
• Sail Number
(You can enter an abbreviation such as "Al" for Albert. “Al “ will find Al. The
Status line will tell you if there is an error. Don’t type the quotes.)
3 - Then click the “Apply Finish” button, (or Tab to the button and press Enter). Race Log will
keep track of the Finishes you apply in the “Status of Last Apply” area. If you get lost you can
click the Down arrow to view your entries. Data will automatically be updated in the data
window when you "Close" the Enter Finishes Dialog Box.
4 – When done with a Race, click
the 1st, 2nd, etc for the new Race.

to advance to the next Race. You will be prompted for

“Add New Sailor” button will add a new racer. When you enter a new racer's Name or Sail Number and
that sailor is not found in your fleet file, the Status line will tell you that no Sailor is found. Then click
“Add” to add the sailor (of Tab to the button and press Enter).
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The Current Race: box in the upper left will automatically position you at the next race to enter. You may
override this by clicking the Arrow buttons or by typing in the specific Race you wish to score or correct.
The Current Finish box in the upper right will automatically prompt you for the next finish. You can
override clicking the Arrow buttons.
Penalties are entered by clicking on the “DNF”, “DNS”, etc. buttons. DNC is assumed if no finish is
entered. After entering a Penalty you can continue entering Finishes. Race Log will keep track of your
next Finish to enter.
If you accidentally or purposefully enter a finish for a racer who already has a finish, you will get a
warning message. You can decide to Override the existing finish, or Cancel and try to enter a different
racer.
If you get lost you can click “Reset for Race” to position at the next Race to enter finishes for, and you
can click “Reset for Finish” to position at the next Finish to enter for the current race.
Click on the “Close” button when you have finished entering your scoring data (or Tab to the “Close”
button and then press Enter).

Data Entry Specifics - “Enter Finishes” via Drag ‘n Drop

Drag from right to left to insert finish, drag from left to right to remove from finish list.
Use the Mouse to drag Sailors from the “Entrants” list on the right to the “Finishers” list on the left.
Finishers are inserted into the finish list depending on where they are “Dropped” with the mouse.
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After dragging a sailor to the finish list, you can change the sailor to a penalty by clicking the finisher
with the “right” mouse button. This will display a list of penalties to select. The list will automatically be
re-sequenced. (You can turn off re-sequencing by selecting “No” at the top of the window.)

Insert Penalty / Finish – Resequence
If you make a mistake entering your Finishes, or if you need to insert a Penalty after you thought you
were done entering Finish data, you can easily update your results. Race Log will analyze your change
and automatically re-sequence all finishes based on what and where you insert a new finish or penalty.
Study the examp les on the next page to better understand how Race Log will handle your change.
Place your cursor in the data screen where you wish to enter a new Finish or a Penalty. The cursor can be
placed on a blank entry, or on an existing finish. Then select the “Edit” | “Insert Penalty/Finish
Resequence” menu item.
The following dialog box will display…

The selected Racer and Race will be display on the above screen so you can verify that you have made
the correct selection. You can navigate to another Racer or Race using the “arrow” buttons. Once you
have the correct spot you can click one of the “Penalty” buttons, or select a new Finish. Then click the
“Insert New Penalty/Finish” button. Race Log will figure out the rest and properly re-sequence all the
Finishes for the affected Race.
Penalties (according to Racing Rules 2000-2004):
DNF
DNS
RAF
DSQ
BFD
OCS
DNE
DNC
SCP
ZFP

Did Not Finish
Did Not Start – came to starting area
Retired After Finish (formerly RET)
Disqualified
Disqualified – over early with Black Flag rule 30.3
Disqualified – over early, rule 29.1 or 30.1
Disqualified Not Excludable – cannot throw out, rule88.3(b) (formerly DND)
Did Not Compete – did not come to the starting area
Scoring Penalty – rule 44.3
Scoring Penalty – Z flag, rule 30.2

RDG

Redress Given – use Over-ride points discussed in next section
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(enter the points in the “New Finish” box with a decimal point;
eg. 2.3 4.0 3. - the presence of the decimal point tells Race Log that this is
Points to be given, not a Finish, and will not be re-sequenced)
New Finish

Enter a new Finish to replace the existing finish, or a new Finish to be placed
in an empty finish slot, without decimal point. Race Log will re-sequence as
necessary. Make sure to click the
New Penalty/Finish” box.

button to post the Finish to the “Verify

Then click the “Apply Insert New Penalty/Finish” button to update your data and re-sequence.

Insert Penalty/Finish Examples…
Before
Current Finishes
John
1
Jake
2
Jane
3
Joshua 4
Jack
5

Jane was Disqualified
Insert DSQ for Jane

After
Resequenced by Race Log
John
1
Jake
2
Jane
DSQ
Joshua 3
Jack
4

Current Finishes
John
1
Jake
2
Jane
3
Joshua 4
Jack
5

Jane should be Second (2 nd)
Insert 2 for Jane

Resequenced by Race Log
John
1
Jake
3
Jane
2
Joshua 4
Jack
5

Current Finishes
John
1
Jake
2
Jane
3
Joshua 4
Jack
5
Jim
_

Jim should be Fourth (4 th)
Insert 4 for Jim

Resequenced by Race Log
John
1
Jake
2
Jane
3
Joshua 5
Jack
6
Jim
4

Current Finishes
John
1
Jake
2
Jane
3
Joshua 3
Jack
4
Jim
5

Duplicate 3’s
Jane should be Fourth (4 th)
Insert 4 for Jane

Resequenced by Race Log
John
1
Jake
2
Jane
4
Joshua 3
Jack
5
Jim
6

Current Finishes
John
1
Jake
2
Jane
4
Joshua 5
Jack
6
Jim
7

Missing 3
Jane should be Fourth (3 rd)
Insert 3 for Jane

Resequenced by Race Log
John
1
Jake
2
Jane
3
Joshua 4
Jack
5
Jim
6
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Race Log will handle any re-sequence situation automatically. However any mistakes such missing
Finishes, or duplicate Finishes will continue uncorrected until you correct the mistake as in the last two
examples. Race Log “Error Checking” will catch these problems at Scoring time.

Clear Finishes from Existing File
You can re-use an existing fleet file and save yourself the effort of re-entering the Sailor’s name and sail
number. To clear the race finish data from a file and leave the Sailors intact select “Clear Finishes…”
from the “Fleet ” pulldown menu. Use “Save Fleet” to write over the existing file and lose the original
finishes. Use “SaveAs…” to write to a new file and keep the cleared finishes in the original file.
Be careful to ensure you don’t have extraneous, or inactive Sailors in your fleet file if your are counting all
Entrants in a series. Every sailor in the fleet file is considered an Entrant in your series whether they have
finishes recorded or not. For more information on this is sue see the “Scoring Options” Section.
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Scoring
How to Score
Once your data is entered simply select "Score It" from the Scoring pulldown menu. The finishes in the
data window will be checked for errors ( if “Error Checking..” under the “Options” menu is turned on) and
a new window will appear with the resulting scores and standings. Notice this window has no command
line at the bottom, has a Grey background, and you cannot edit the data in this window, this is a result or
report window. You may use the Mouse or scroll keys, F8 and F9 for left and right scrolling, and the
Page Up and Page Down keys, to view the results.

Next you may print the results by selecting Print selections from the "Fleet" pulldown menu. You will be
prompted for a new title, just hit the Enter key or click the OK button to use the default title. (Don't click
on CANCEL unless you want to cancel the Print request.) You're done.
Don't forget to save your data. The result window isn't actually data, you must get back to the data
window and type "save" on the command line or select "Save Fleet" from the pulldown menu. The data
file and data window will always contain exactly what you enter. Conversions to scores such as DNC's, or
scoring 1st as .75 will be done automatically by Race Log and then used in calculating your total Score.
However the data in the file will not actually change to .75, it will stay "1" in the data file.

Penalty Scoring
Race Log uses the following definitions for penalties as specified in the Racing Rules 2000-2004. Race
Log automatically computes the score for each penalty based on your settings of the Scoring Options for
your scoring method, see the section on Scoring Options for more information:
Penalties (according to Racing Rules 2000-2004):
DNF

Did Not Finish
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DNS
RAF
DSQ
BFD
OCS
DNE
DNC
SCP
ZFP
RDG

Did Not Start – came to starting area
Retired After Finish (formerly RET)
Disqualified
Disqualified – over early with Black Flag rule 30.3
Disqualified – over early, rule 29.1 or 30.1
Disqualified Not Excludable – cannot throw out, rule88.3(b) (formerly DND)
Did Not Compete – did not come to the starting area
Scoring Penalty – rule 44.3 (Low Point Method only)
Scoring Penalty – Z flag, rule 30.2 (Low Point Method only)
Redress Given – use Over-ride points discussed in next section

Override Points
Situations arise which require that you override the points calculated for a racer by Race Log. This
situation can occur if you have a protest and need to adjust scores (RDG), or if you provide series credit
for sailing in out of town regattas, and so forth. Since the data you normally enter is the actual Finish,
you need to let Race Log know that the number you enter is either a “Finish” or actual “Points”. The
default is “Finish”. If you must enter Override Points, enter the “Points” you want the racer to earn in
the appropriate Race column. Include the decimal point whether you enter a whole or fractional number.
A maximum of 1 digit is allowed after the decimal. This is done in the Data window, or the “Enter
Penalty/Finish” dialog box.
Examples of valid Override Points entered in a Race column: 2.5
Examples of invalid Override Points: 2
3.55

2.0

3.

8.1

The decimal point must be included or Race Log will assume you have entered the racer’s “Finish”. An
error message will indicate a problem with too many decimal points. You may need to turn off Error
Checking (see Error Checking section) if your scoring situation results in gaps in your finishes, such as
no 3rd place finisher. This is a condition which is automatically checked for by Error Checking. You may
need to turn it off before Scoring by selecting “Options” | “Error Checking”.
for Low Point, Low Point Averaged, and Olympic Methods: The Override Points you enter are actual
points earned for that race.
for High Point Method: The Override Points you enter are not actual points, but represent a
compromise finish. If you enter 2.5 then the Race Log program will treat this as a finish
between the 2nd place finisher and the 3rd place finisher and calculate points based on that
sequence of finishers.

Select “Score” | “Score It”…
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Select “Score” | “Score It”…

Set Race Range to Score…
This Dialog box appears when you select the “Score It” menu selection to Score your fleet. The First
Race and Last Race is automatically set to all races. Or a specific range of races to be scored can be
selected, such as the past weekend’s results. Use the Arrow buttons to set the FIrst and Last race you
wish to Score.
Normally you will Score all races to establish standings for all of your scoring data. Or you may select a
subset of races and establish s tandings based only on those selected races. This allows you to keep all
your fleet data for a whole season in one file, and optionally score the whole season or score a specific
weekend from the same data file.

Throwouts
Race Log will exclude from scoring a racer’s worst finishes. This is done by specifying a “Percentage” of
races to throw in the Scoring Options dialog box. Select “Score Options…” from the “Options”
pulldown menu. The percentage entered (20 for 20%) will be rounded down to ensure that no more than
the specified percent will be thrown.
Each time you score you have the opportunity to over-ride the Throwouts Percent in the above Dialog
Box with an actual number of races to throw. You may enter any number 0 or greater to indicate how

45

many races to throw from this scoring. Leave the over-ride entry field blank to use the Throwouts Percent
you set in the “Score Option Settings…” dialog box.
For more information on Throwouts for you selected Scoring Method see the section on Scoring Options.

Error Checking
If there are any errors in your scoring data they will be found when you Score. Error messages will be
displayed indicating the problem. Race Log will check for:
•
•
•
•
•

missing finishes
duplicate finishes
finishes higher than the number of participants
minimum participation requirements
inconsistent throwout option

Correct the errors and then re-Score.
Error Checking can be turned off by selecting “Options” | “Error Checking…”. This is useful if duplicate
finishes need to be entered in special scoring situations. If you need to score in this manner, it is wise to
first score with Error Checking on just to check your data. Then turn Error Checking off to produce your
standings.
Error checking is automatically disabled while scoring subsets (Class or Division) to compensate for
missing finishes.
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Scoring Options
Scoring Method and Settings
Scoring Method: This is set by choosing " Score Method" from the "Options" pulldown menu. You may
select one of:
• Low Point
• Low Point Averaged
• High Point
• High Point Averaged
• High Point Fixed
• High Point Fixed Average
• Bonus Point ( old Olympic method)
• Squares of 40

Many scoring options settings are available for each Method. The current settings will be displayed.
Once you have the Scoring Settings dialog box available you can make your changes and then click the
“Apply Changes” button.
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High Point Method:
A First receives the highest score. Each yacht is scored one point for finishing (see Finish Bonus) and
one point for each starting yacht it beats. Each yacht's score is totaled and the highest score wins.
Throw-outs are now available for all High Point methods (High Point, High Point Ave, High Point Fixed,
High Point Fixed Ave), although when you throw out a DNC which has a score of 0 you are not changing
the resulting score. However the throwout action will level the playing field by eliminating x number, or
x% of races from each participant.
Options for High Point Score Settings...
Throw Outs: Set pecent of races to throw out
Finish Bonus =: This specifies how many points to add to each Finishing yacht. This is typically 1,
however the number can be changed here. A yacht's score is the number of yacht's it beats plus this
bonus.
Start Bonus =: This specifies how many points to add to each Starting yacht. This is typically 0,
however number can be changed here. A Start bonus makes non-attendance more severe
Bonus for 1st, 2nd, 3rd: A partial point bonus, such as .25, or any decimal number less than 1, will be
added to each 1st (or 2nd, or 3rd). Each bonus may be a different value or 0.
DNC: This value specifies how many points will be scored for a non-starter. This is usually set to 0 for
the High Point Method since usually only Starters are calculated in the score.
CountDNC’s: Select whether non-Starters, (DNC's), are counted as beaten yachts in the High point
scoring. The default is *Not Counted*. If set to Counted, then non-Starters are counted as defeated in
races in which they did not start when calculating a score.
DNS, DNF, RAF: This value specifies how many points will be scored for a Did Not Start, Did Not
Finish, and Retired. This is usually set to 1 for the High Point Method.
DSQ, OSC, BFD, DNE: This value specifies how many points will be scored for a Disqualification,
Disqualified Not Discardable, and On Course Side (Over Early) usually a 1, but greater than a DNC.
Minimum Starters: This tells the Race Log system not to score a race below a minimum number of
racers. An error message will alert you to this condition when scoring.
% of Races to Qualify: Used to ensure that a racer has sailed in the specified percentage of the total
number of series races in order to qualify for a series. Enter 0 if no checking is required. This is usually
set to a percentage > 0 on the last "scoring" of the season to produce the final standings.
If a racer started in less than the required % of races, then he will not have a total score (“NC” for not
counted). He may, however, be counted as a participant based on the setting of “Counted” or “Not
Counted” above.
This option is not as important for High Point as other methods since participation is rewarded with
points.

High Point Average Method:
A First receives the highest score. Each yacht is scored one point for finishing (see Finish Bonus) and
one point for each starting yacht it beats. Each yacht's score is totaled and divided by the number of
races it Starts. The highest score wins. Throw-outs in this method don't make sense so they are not
calculated.
See High Point Method above for option settings.
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High Fixed Point Method:
A First receives the highest score. This score is pre-set by the race committee and set in the “Top Score”
box. Each subsequent finisher is scored one point less than the yacht ahead. Each yacht's score is
totaled and the highest score wins. If the Top Score is less than the number of Starters, Race Log will use
the number of Starters as the Top Score. This may not produce the results you are seeking so make sure
your High or “Top” points are set properly
See High Point Method above for option setting, but following are considerations for High Fixed…
Finish Bonus, Start Bonus don’t make sense for High Fixed method since the High Score is already set
and is the same for each racer and each race, although they can be set.
Bonus for 1 st, 2 nd, 3 rd : These settings don’t make sense for High Fixe d method since the High Score is
already set and is the same for each racer and each race, although they can be set.
CountDNC’s: This should be set to NO for High Point Fixed

High Fixed Point Average Method:
A First receives the highest score. This score is pre-set by the race committee and set in the “Top
Score..” box. Each subsequent finisher is scored one point less than the yacht ahead. Each yacht's score
is totaled and divided by the number of races it starts. The highest score wins. Throw-outs in this
method don't make sense so they are not calculated. If the Top Score is less than the number of Starters,
Race Log will use the number of Starters as the Top Score.
See High PointFixed Method above for option settings and further conderations for all High Point
Fixed methods.

Squares Method: (Squares of 40)
This is the same as High Point Fixed Average, except that the points are squared before calculating the
standings. The results are then averaged. This method is used by the Snipe Class. Race Log allows you
to pick 40 (the default), or any other number as the High or Top score. So in effect you can do a “Squares
of Anything” method. All the Options for this method have the same considerations and comments as
“High Fixed Point Average” above.
See High PointFixed Method above for option settings and further conderations for all High Point
Fixed methods.

Low Point Method:
A First receives the lowest score, usually 1 or .75, based on your settings in the Scoring Settings. A
Second receives a 2, and so on, as specified by US Sailing Association's "International Yacht Racing
Rules". A racer's standing is based on the sum of his finishes counted. This method is the most popular
scoring method. However this method usually will require using the Throwouts option for scoring a
whole season where weekly participation varies.
Throwouts: This setting establishes the percent of races to throw out. The result window will show how
many points each racer has earned for his/her best races not thrown out. Races will be thrown starting
from the lowest scores per racer including DNC's. In addition to regattas, this entry is helpful for seasonal
scoring to address the fact that most entrants will miss some of the races. A setting of 20 indicates 20%.
If 20% represents a fractional number then the number of throwouts is rounded down.
First Place Points: This is usually set to 1.00 or .75 for Low Point (Other numbers can be entered just for
fun).
DNC = Entrants, or Starters +: The Did Not Compete penalty equals the number of Entrants (or Starters
) plus the penalty number entered here. This is typically 1 or 2 for the Low Point Method.
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DNF = Starters, or Entrants, or Finishers +: Penalty for those receiving a Did Not Finish. This will be
added to the number of starters, entrants,or finishers for each race. The number of starters and finishers
may be different for each race, and may be less than the number of entrants. This is typically 1 for Low
Methods.
DNS, RAF = Starters, or Entrants +: Penalty for those receiving a Did Not Start, or Retired. This will be
added to the number of starters or entrants for each race. The number of starters may be different for
each race, and may be less than the number of entrants. This is typically 1 for Low Methods.
DSQ, OSC, BFD, DNE = Starters or Entrants +: Penalty for those receiving a Disqualified, Disqualified
Not Discardable. This will be added to the number of starters or entrants for each race as set above for
the “DNS, RAF” setting.
SCP, ZFP: The Scoring Penalty is added to the Finish entered into Race Log. The Penalty is a fixed
Value, or a Percent of Entrants (typically 20%). The resulting points is always less than or equal to a
DNF. The Race Log score report will show the Finish with an “S” or “Z” next to it. The SCP and ZFP
penalty applies only to the Low Point scoring method.
Minimum Score for DNC: Use this setting to set a minimum score which will be used if the number of
entrants in a fleet varies widely from week to week. A setting such as 10, for example, will level the DNC
penalty scores.
Minimum Starters: This tells the Race Log system not to score a race below a minimum number of
racers. An error message will alert you to this condition when scoring.
% of Races to Qualify: Used to ensure that a racer has sailed in the specified percentage of the total
number of series races in order to qualify for a series. Enter 0 if no checking is required. This is usually
set to a percentage > 0 on the last "scoring" of the season to produce the final standings.
If a racer started in less then the required % of races, then he will not have a total score (“NC” for not
counted). He is, however, counted as an entrant in the series. This affects the DNC, DNF, etc. scores if
these penalties are to be added to the number on Entrants. This option is useful for the Low Point method
for seasonal scoring to ensure that a minimum participation is achieved.

Low-Point Averaged Method:
A First receives the lowest score, usually 1 or .75, based on your settings in the Scoring Settings. A
Second receives a 2, and so on. This method is described in Appendix B2A of US Sailing's Racing Rules
book. A racer’s standing is based on the average of his finishes counted. This method does not reward
participation so use of the ”% of Races to Qualify” option is necessary to score an extended series to
prevent a one or two time winner from walking away with a series. DNC's are not calculated in the score,
just the races which are started. A race which is not attended is considered not scored
Throwouts: This setting establishes the percent of races to throw out. The result window will show how
many points each racer has earned for his/her best races not thrown out. Scores are thrown starting from
the worst scores per racer not including DNC's. DNC's are not considered as part of the score in this
method. Using a percentage implies that each racer may receive a different number of throwouts
depending on how many of their races are scored. A setting of 20 indicates 20%. If 20% represents a
fractional number then the number of throwouts is rounded down.
First Place Points: This is usually set to 1.00 or .75 (Other numbers can be entered just for fun).
DNC = Starters or Entrants +: This value is not used in the Low-Pt Averaged method. DNC's are not
calculated in the score, so the "% of Races to Qualify" setting is necessary in order to insure accurate and
fair scoring.
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DNF = Starters, Entrants, or Finishers +: Penalty for those receiving a DNF. This will be added to the
number of starter, entrants, or finishers for each race. The number of starters and finishers may be
different for each race, and may be less than the number of entrants. This number is typically 1 for Low
Methods.
DNS, RAF = Starters or Entrants +: Penalty for those receiving a Did Not Start, or Retired. This will be
added to the number of starters or entrants for each race. The number of starters may be different for
each race, and may be less than the number of entrants. This is typically 1 for Low Methods.
DSQ, OSC, BFD, DNE = Starters or Entrants +: Penalty for those receiving a Disqualified, Disqualified
Not Discardable, and Retired. This will be added to the number of starters or entrants for each race based
on the setting for “DNS, RAF”. The number of starters or entrants may be different for each race, and
may be less than the number of entrants. This is typically 1 for Low Methods.
SCP, ZFP: The Scoring Penalty is added to the Finish entered into Race Log. The Penalty is a fixed
Value, or a Percent of Entrants (typically 20%). The resulting points is always less than or equal to a
DNF. The Race Log score report will show the Finish with an “S” or “Z” next to it. The SCP and ZFP
penalty applies only to the Low Point scoring method.
Minimum Score for DNC: Not used for this method.
Minimum Starters: This tells the Race Log system not to score a race below a minimum number of
racers. An error message will alert you to this condition when scoring.
% of Races to Qualify: [This Setting is most important for Low Pt Average.] This specifies the
percentage of all races in which a racer must participate in order to qualify for the series. This is generally
set to 0 to allow all racers to be included in day to day or weekly scoring for a long series, however this
may provide inaccurate standings for the Low-Pt Averaged method. This setting is extremely important
for this method since only the races started are included in the scoring calculation. If a racer has one 1st
and then all DNC's he would be in first place (or tie for first) unless this setting sets a minimum
participation requirement.

Bonus Point Method:
A First receives 0, Second - 3, Third - 5.7, Fourth - 8, Fifth - 10, Sixth - 11.7, Seventh and thereafter - Place +
6 as specified in by US Sailing Association's "International Yacht Racing Rules". A racer’s standing is
based on the sum of his counted finish scores, higher finishes being penalized as the above scores
st
nd
indicate. This type of method is call a “spread” method since there is a bigger spread between 1 and 2
th
th
nd
st
for example, than between 10 and 11 . The reasoning is that it is harder to move from 2 to 1 than
th
th
from 11 to 10 .
Throwouts: This setting establishes the percent of races to throw out. The result window will show how
many points each racer has earned for his/her best races not thrown out. DNC's will be the first races to
be thrown out.
First Place Points: Bonus Point is automatically set to 0 points but you may override this.
DNC = Entrants, or Starters +: The Did Not Compete penalty equals the number of Entrants (or Starters
) plus the penalty number entered here. This is typically 1 or 2 for the Bonus Point Method.
DNF = Starters, or Entrants, or Finishers +: Penalty for those receiving a Did Not Finish. This will be
added to the number of starters, entrants,or finishers for each race. The number of starters and finishers
may be different for each race, and may be less than the number of entrants. This is typically 1 for Bonus
Method.
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DNS, RAF = Starters, or Entrants +: Penalty for those receiving a Did Not Start, or Retired. This will be
added to the number of starters or entrants for each race. The number of starters may be different for
each race, and may be less than the number of entrants. This is typically 1 for Bonus Method.
DSQ, OSC, BFD, DNE = Starters or Entrants +: Penalty for those receiving a Disqualified, Disqualified
Not Discardable. This will be added to the number of starters or entrants for each race as set above for
the “DNS, RAF” setting.
Minimum Score for DNC: Use this setting to set a minimum score which will be used if the number of
entrants in a fleet varies widely from week to week. A setting such as 10, for example, will level the DNC
penalty scores.
Minimum Starters: This tells the Race Log system not to score a race below a minimum number of
racers. An error message will alert you to this condition when scoring.
% of Races to Qualify: This specifies the percentage of all races in which a racer must participate in
order to qualify for the series. This is generally set to 0 to allow all racers to be included in day to day or
weekly scoring for a long series This option is useful for the Bonus Point method for seasonal scoring to
ensure that a minimum participation is achieved.
Note: You may want to score your data using more than one method in order to compare the results of
different methods. After you score the data using "Score It" from the pull down menu or by typing the
"score" command, you may change the method as described above. Then get back to your data window
and "score" again. You will now have two result windows to compare. You can create as many scoring
result windows as you need.
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Printing
Select “Print…” from the “Fleet” menu, or the Printer icon of the button bar…

Print Options screen
Three Print methods are available…
Standard Print
Web Format
WordPad Format
Standard Print – prints directly to your default printer.
Web Format – saves the report to a “.htm” file and displays the output in an “Internet Browser”
format. From here you can view the results, print the results, and upload the results to your personal
folder at the Race Log website. This will publish your results to anyone who has access to the
internet.
WordPad Format – saves the report to a “.wri” file and displays the output in Windows WordPad
utility. From here you can format and edit the output to your liking and then print using WordPad’s
print capabilities.
You can use the capabilities of WordPad such as “Edit” | “Select All” and then change the font size,
or select certain text to Bold, Italicize, or change color, etc. You can also use “File” | “Page Setup…”,
or “File” | “Print” to change to Landscape printing for fleets with a large number of races printed
across the page. It is recommended that you NOT change the Font since some Fonts are
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“proportional” Fonts. Race Log prints in columnar fashion and the proportional Fonts lose the
columnar orientation (ie. Things won’t line up!).
All of the report files are saved in the \Rlog\Reports directory so you can print again without re-scoring.
Enter File Name - You can choose a file name or let Race Log generate one for you for the Web Format
and the WordPad Format. If you choose your own filename you must include the “.WRI” or “.HTM”
extension.
Page Width - You can set the output width for Web Format and the WordPad Format (in number of
characters on a line). A larger number will allow a more Races printed across the page in Landscape mode.
WordPad - Valid entries range from 60 to 156 characters. A maximum of 156 with a Font size of 8pitch allows for the widest printing of race results without wrapping onto a new line.
Web Format – Valid entries are from 1 to 60 Race columns across the page. You can fit more with
a smaller font.
Set Report Font – You can select the Font type, and Font size used to print your report for the Standard
Print, and the Web Format output type. This will allow you to fit more data across the page with a smaller
font. “1 (8 pitch)” is the smallest font size.
Race Dates - You can specify whether you want the Dates you entered in the fleet data window to print
on the report.
Score Options – You can specify whether the score method and other settings which explain your results
are printed at the beginning of your report.
Shading – For the Direct to Printer, and Web formats, this will highlight with shading every other racer on
the score report. (Web format will display the shading, however to print with the shading from a web
format or web browser you must configure your browser to allow printing background colors.)
Borders – For the Web format, this will print borders around each item on the report for easier reading of
results. This can be used with or without Shading.

Upload Results to Internet
Automatic upload of results to internet – Results can be hosted at Race Log website for users of Race
Log. Users will be assigned a User ID which creates a personal folder on the Race Log website. Results
can be uploaded to internet at the click of a button.
You will need to create a UserID if you do not already have a Race Log UserID. You can check to see if
the User ID you want is available at the Race Log website – click on the “Find a User ID” link at
www.racelog.com, or see the “Race Log UserID” section below. You can create a UserID from within
Race Log if you are on-line (connected to the internet). A UserID must be between 3 and 15 lower case
letters only. No numbers, punctuation, or special characters.
Uploading is done by selecting the "Web Format" on the "Print Options" screen shown above. When
you attempt to upload, Race Log assumes you are connected to the internet. If not you will get an
appropriate error message. All you have to do is go through your normal dial-up routine, or just make sure
your connection is active if you have DSL or Cable access - then click the Upload button.
Your uploaded results are viewable on the internet at "http://www.racelog.com/results/youruserid". The
print file created by the upload process has a extension of ".htm", and is saved in the \Rlog\reports
directory on your computer. The file can be printed again, uploaded again, and emailed to others. This
file can be uploaded to other websites as well using tools provide by the hosting website.
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Only one report can be uploaded. The next time you upload you will overwrite your previous upload.
You can upload as many times as you wish. If there is a connection problem when you attempt to upload,
just try again. The Race Log website is hosted by one of the many commercial web hosting companies.
The hosting company, not ELB Software, is responsible for maintaining adequate performance and
availability.

Following is the screen produced by the “Web/Format Upload” print selection…

This screen allows you to preview the results as they will appear on the internet. From this screen you
can…
Print
Upload
Open a previously saved web format report
Print – Print the report by clicking the “right” mouse button over the report. This will display a pop-up
menu. Select the Print option to print your report in Web format. The report will use the Font type and
size you selected on the Print Options screen. This allows you to control how much data prints across a
page. Title and column headings will be bolded to produce an easy to read report.
Upload – Click the “Upload” button to upload the currently displayed report to your own personal internet
folder on the Race Log website. Your report will be available at the following URL…
http://www.racelog.com/results/youruserid
The folder will hold one report, and each upload will overwrite your previously uploaded report.
Open – You can open a previously created report as long as you used a unique filename when you
created it. Select “Open” from the “Reports” menu.
The following screen is displayed when you click the “Upload” menu…
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Upload screen

Connecting to the Internet
At this point you should be connected to the internet via your dial-up connection, or your cable or DSL
connection. If you must “dial” to get to the internet, leave this screen (don’t Close it), find your dial-up
connection icon on your desktop or Windows Start menu. If you use AOL, connect to AOL in the normal
manner. Return to this screen, select your UserID from the drop-down list box, then click the “Upload”
button. The UserID selection list will typically show just one UserID. However Race Log is set up to
eventually allow you to acquire multiple folders for uploading results – ie. multiple UserID’s.
The “Status” line will alert of success, or of problems during the upload process. Once your Upload is
complete, then “Close” the screen and continue your scoring tasks. The Uploaded results are now
available on the internet at the URL listed on the screen.
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Race Log UserID
The Race Log UserID is used for specifying a folder on the Race Log website where your score results
can be easily uploaded and made available on the internet. The “Upload” function is described above. It
is done from within Race Log and is extremely easy to use. You can upload your results without requiring
your computer or internet expert technician to be involved. A UserID must be between 3 and 15 lower
case letters only. No numbers, punctuation, or special characters. This is described in the “Uploading
Results to Internet” section above. More information on the UserID function is at the Race Log website
www.racelog.com. You can also check to see if the ID you wish to use is available at the website, or on
the screens described below.
The Shareware version of the product allows only one UserID to be defined per copy of Race Log. The
Upgrade version allows multiple UserIDs to be set up providing multiple folders for uploading results.
Your club can use multiple ID’s for each of your racing classes – clubasunfish, clubalaser, etc.

Create a UserID
From the “Options” menu select “UserID” to check the availability of, and to create a UserID. This menu
item is in both the “Registration View” and the “Racing View” of Race Log.

UserID Menu

Selecting the “UserID” menu item will open the Setup UserID screen below…

Setup UserID screen
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If you already have a UserID it will be displayed and the Status message will tell you it is already set up as
shown above. You can have up to 3 with the Shareware version and 15 with the Pro verion in order to
handle your multiple fleets and regattas.
If there is no UserID set up yet, then enter the UserID you want and click the “Check” button. The
Status message will tell you if your selection is available to use. If available then fill in your Name, Sailing
Club, and email (in case you need to contacted regarding website problems). Click the “Create” button
and watch for a successful status message. You can now use the Upload function.
If you already set up a UserID, either on the Race Log website at –
http://www.racelog.com/results/rlogt_choose.htm, or in Race Log as described above in a previous Race
Log session, and that UserID is not showing up on the above screen, then you can use the “Check”
function to see if it is actually setup on the Race Log website. When you click “Check” Race Log will tell
you if the UserID is already setup, and will display user/owner data. If this is your UserID then you can
click “Use It” to hook up to it. You will be prompted with a message asking if this is really your UserID
for verification purposes.
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Dealing with Multiple Classes/Divisions
How to use Class or Division field
You may keep track of multiple Classes and / or Divisions of sailors in the same fleet file. You may score
them separately or score all Classes or Divisions along with the whole fleet. An example of this is
"Junior" sailors racing with your fleet. Simply score their actual finishes to see how they stand within the
whole fleet. Indicate they are Juniors by typing something in the Class column such as "JR". Select
"Select Class" or “Select Division” from the "Score" pulldown menu and enter "JR" for your selection
criteria. You may select up to three values of Class or Division to create a new subset window. (The Race
Log system make no difference between Upperand Lower Case searches.) A new window with the
subset of “juniors” you selected will appear. You may also get a message indicating that the data could
not be found. Once the window appears simply score this group as described above. The only difference
in scoring a subset is that you will be asked if you wish to have the subsetted racers scored using their
actual finishes, or with their finishes converted relative to 1. You may optionally use “SaveAs” to save
the data in the subset window to a separate file.
When you score a subset window, you will be asked if you wish to score “Relative to One”. If you chose
YES you will eliminate the gaps in finishes due to the fact you aren’t scoring the whole fleet. The finishes
will be converted to 1 through ….n for the standings. The data in the fleet file is NOT changed however.
If you chose NO for “Relative to One” then the finishes from the original data window will not be altered.
The resulting score will be identical to the score a racer receives in the whole fleet scoring. In order to
perform scoring of a subset window with NO for “Relative to One”, Race Log requires that you first score
the whole fleet. Race Log will provide a warning message if you haven’t done this.

Select Top Finishers
Select the "Select Top Finishers.." menu item from the "Score" pull-down menu. This option is used to
select the Top 10, Top 20, Bottom 10, or any other range of Finishers in order to subset the fleet for further
scoring. In order to do this you must first score the whole fleet so that an ordering can be established by
Race Log. The range of finishers is selected from the Score Result Window which displays your
standings, and then a new window with the selected finishers is opened. You can Score this new
collection of racers. As with any SCORE'ing from a subset window you will be asked if you want to
convert the scores relative to 1. You may optionally use “SaveAs” to save the data in the subset window
to a separate file.

Custom Selection
You may use the “Select” command (see Commands below) to split a fleet apart using your own selection
criteria. Example:

Select IL in St
This command will create a new window with only sailors from the State (St) of Illinois (IL) by selecting
the IL’s from the St column. This subset may be scored separately. Scoring will work as discussed above
in the “Class or Division” paragraph.
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Command Line
Various commands are available in the Racing View of Race Log. You may enter these commands on the
command line. (Ignore Case except when entering Column names).
SCORE

SCORE

to score (same as selecting from pulldown menu).

FIND

FIND "CHARLIE" to locate Charlie in your data window, the search always
starts at the beginning of the file and searches all columns and records. The
quotes are optional.
FIND CHARLIE in Name to locate a record with Charlie's in the Name
column.
FIND 1 in RC_9 to locate the winner of the ninth race.

FINDN

FINDN RALPH to Find the Next occurrence of Ralph after an initial FIND
command positions you into the data.

*** FIND and FINDN(ext) are repeatable commands. Just hit the Enter key after a FIND in order to repeat
the FIND.
LOCATE

LOCATE 15

positions you at the 15th record or line in the active window.

PRINT

PRINT
to print the active window, can be a data window or a result
window with standings

SELECT

SELECT "JR" IN Class
to create a subset window with Junior racers.
SELECT "SMITH" IN Name to create a subset window with all the Smith's
who are in the data window. ( IN limits your search to a Column; all data
columns will be searched if you don't use the IN parameter.)

TOP

TOP

BOTTOM

BOTTOM
window.

REMOVEID

REMOVEID (or abbreviate to RID)
to remove the current window.
RID 03
to remove the window labeled with ID 03.

CHANGEID

CHANGEID 03 (or abbreviate to CID)
03.

to position you to the top, or first record in your active window.
to position you to the bottom, or last record in your active

to switch to the window labeled ID

SORT

SORT Class
to redisplay your race data in sequence by Class, this will
group together racers in the same Class. Up to 3 classes may be entered to do
sorts within sorts.
SORT Class Number to sort by Sail Number within Class.
SORT RC_2
to sort by the finishes in Race 2, ie. show the standings for Race
2 only.

SAVE

SAVE
saves the data in the currently active window (same as selecting
SAVE from the FILE pulldown menu).
The file will be saved in the \RLOG\DATA directory unles you type in a
specific path.
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SAVEAS

SAVEAS A:FLEET.DAT saves the data in the currently active window into
the specified file which may or may not already exist. You will be asked
permission to overwrite an existing file. This is a handy way to create a backup
of your fleet onto a floppy disk (same as selecting SAVEAS from the FILE
pulldown menu).
The file will be saved in the \RLOG\DATA directory unles you type in a
specific path.

SAVEONTO

SAVEONTO A:BIG.DAT saves the data in the currently active window
onto the end of the specified file. You will be prompted if the file does not exist
in order to create a new one. This will allow you to add racers to the racers on
an existing file, but it does not add races onto an existing file (same as
selecting SAVEONTO from the FILE pulldown menu).
The file will be saved in the \RLOG\DATA directory unles you type in a
specific path.

Many of the above actions can be accomplished by mouse clicks such as clicking on a partially hidden
window to bring it to the front (the CHANGEID command).
Each command can be abbreviated by typing enough of the command to make it unique from another
command such as L for LOCATE. But S for SAVE is not unique due to SAVEAS, SAVEONTO and
SELECT. In addition the CHANGID and REMOVEID commands have special abbreviations as indicated.
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Keyboard Map and Hot Keys
(letters may be UPPER or lower case)
Alt-E
invoke Edit menu
Alt-H
invoke Help menu
Alt-F
invoke File menu
Alt-O
invoke Options menu
Alt-P
invoke Print menu
Alt-S
invoke Score menu
Alt-W
invoke Window menu
Alt-X
Exit Race Log
Arrow(s)
moves cursor
Delete
deletes character at cursor
Ctl-Delete
deletes record at cursor
F1
invoke Help for current context
F2
insert record before cursor
Ctl-F2
insert record after cursor
F3
repeat character from line above
F4
F5
turn off indenting for Enter key
F6
next window
F7
F8
scroll one page left
Ctl-F8
scroll to far left
F9
scroll one page right
Ctl-F9
scroll to far right
F10
invoke menu
Home
toggle cursor between command line and data window
Insert
toggle between Insert and Overtype mode
PageUp
scroll up one page
Ctl-PageUp
scroll to top
PageDown
scroll down one page
Ctl-PageDn
scroll to bottom
Tab
move cursor to next column
Shift-Tab
move cursor to previous column
Hot Keys on Menu items are highlighted in Red
Additional notes about the Keyboard:
Home

Toggles the cursor between the command line and the data portion of the
window. Home also returns the cursor to the beginning of the command line if
the cursor is elsewhere on the command line.
The mouse can also be used to toggle between the data portion and command
line of a window. Click anywhere on the command line or copyright line to
position cursor to command line. Click anywhere on the data portion of the
window to position cursor to data entry area.

Insert

Changes the typing mode from Insert mode to Overtype mode, and back again
(just like a Word Processor.)

Delete
Processor.)

Deletes the character where to cursor is positioned (just like a Word
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Backspace

Backs up the cursor and overtypes whatever is there (just like a Word
Processor.) However the cursor stays in the column where you are typing.

Formats
Race Log (in the Racing View) allows you to select from four pre-defined screen Formats to control what
type of data you wish to enter and display for each racer. Select the Format from the menu and the format
will change, or select “Customize Screen Format…” and pick your own format.

Screen Formats
Normal format -

Name... Class Number RC_1 RC_2 RC_3 ...
xxxxx
xx xxxxxx
1
1
2

Short format -

Name... Number
xxxxxx xxxxxx 1-1-2-ds-4

Club format -

Name... Class Number Club
xxxxxx xx
xxxxxx xxxxx 1

RC_1 RC_2 ...
1

Country format -

Name... Class Number Club Ctry
xxxxxx
xx
xxxxxx
xxxx xxx 1

RC_1 RC_2 ...
1

The format can be changed to accommo date the amount of data you want to keep for a racer. You can
change from one format to another by selecting the "View" menu. For example if you enter data using the
“Club” format and then change to the “Short” format, your data is still there, its just not displayed.
The screen format is automatically saved when the fleet file is saved. When a file is opened it will display
in the last format used when the file was saved.
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Report Formats
Normal format -

Name... Class Number R_1 R_2 R_3 ...
xxxxxx
xx
xxxxxx
1
1 3

The report format is changed by selecting "View" | “Customize Report Format...". The report format
determines how the score results are displayed on the screen and on the printer. The report format can be
Set for the duration of the Race Log session, or can be Saved to make it permanent.

Customize Your Own Formats
In addition to the above fixed Formats, you may customize your own Format by selecting which Fields to
include in your screen or report. Select “View” | “Customize Screen Format…” or any of the Format
menu items. A list of available Fields is displayed. Just click the Fields you wish to keep track of and
Race Log will do the rest. You may switch back and forth from a Fixed format to the “Build Your Own”
format. “Name” and “Sail Number” are required.

Fields for Screens
Name
Class

Column Heading
Name……….
Class

Required
X

Division

Division

Sail Number
Sailing Club
City
State
Country
Gender
Member
Age
Finishes

Number
Club……..
City
St
Ctry
Gender
Mbr
Age
RC_1, RC_2, etc

X

Fields for Reports
Name
SCORE
Total

Column Heading
Name……….
SCORE
Total

Required
X
X

Class

Class

Division

Division

Sail Number
Sailing Club
City
State
Country
Gender
Member
Age

Number
Club……..
City
St
Ctry
Gender
Mbr
Age

X

X

Description
Sailor’s Name, 20 positions
Class such as “Jr”, “Blu”, “Red”, etc.,
3 pos
Division such as “Jr”, “Blu”, “Red”,
etc., 3 pos
Sail Number, 6 pos
Sailor’s home club, 12 pos
Sailor’s City
Sailor’s home State, 2 pos
Sailor’s Country, 3 pos
Sailor’s Gender – 1 pos, M, or F
Membership status, 1 pos
Sailor’s Age, 2 pos
Finishes for each race

Description
Sailor’s Name, 20 positions
Computed points for standings
Points before throwouts are
subtracted, only for Low Point
Methods, required by Hobies
Class such as “Jr”, “Blu”, “Red”,
etc., 3 pos
Division such as “Jr”, “Blu”, “Red”,
etc., 3 pos
Sail Number, 6 pos
Sailor’s home club, 12 pos
Sailor’s City
Sailor’s home State, 2 pos
Sailor’s Country, 3 pos
Sailor’s Gender
Membership status, 1 pos
Sailor’s Age, 2 pos
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Finishes

RC_1, RC_2, etc.

X

Finishes for each Race
Columns (column headings)
Short (string of finishes)

Team Scoring (not yet activated for Release 3.x)
Overview:
Race Log can keep track of up to 4 teams in each fleet file. It’s easy to score Teams by specifying a Team
for each sailor and then Scoring the fleet as you normally score. When the Score Results window appears
you can then Score the Teams to find out the Team ranking.
Instructions:
First go to to ”Options” | “Team Scoring Setup…” set the View to Team mode. You will be asked to
select a Team Screen Format, then “Team Report Format…” to set up your desired Views. See Screen
Formats and Report Formats above to review what the various Formats look like. “Team” will be
substituted where “Class” is shown in the Formats listed above.
You will then be asked to identify the Teams you wish to score in the Dialog Box shown below. You can
specify up to 4 Teams to score against each other. The data you select in from the Team Column in the
fleet data window. This Dialog Box will also be presented again when you actually score the Teams to
allow you to change your mind about the Teams.
This screen is from the old Race Log 2.9 version ( a new similar screen will be set up in version 3.0 )

Then Score in a normal fashion using any of the Data Entry and Score Methods. The entire fleet will be
ranked as in any non-team Scoring.
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Teams are scored after you Score the whole fleet. When the Score Result window is displayed, select
“Score” | “Score Team..”. The Team Standings will appear in a new window with the Total Points for
each Team. All Team members scores will be totaled, and then ranked.

Select a Print method to print your results while the Team Standings Window is still displayed. The
Team Results will be printed along with the full Results if the Team scoring has been done.
The Team Standings widow will close when the Score Results window is closed.
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System Settings
The "System Settings" selection on the "Options" pulldown menu is where you change the Printer type
as mentioned above. Settings for Maximum Racers and Maximum Races are shown on this menu.

System Limits:
(These settings can be left alone unless you have a very large file with a large number of racers and/or
a large number of races. A higher number may reduce performance, and a lower number means
better performance )
Maximum Number of Races - This is set to 200 by default. This means that a maximum of 200
races can be entered for each racer into a scoring file. (Pre-set to 6 for Evaluation Version).
Maximum Number of RaceRs - This is set to 300 by default. This means that a maximum of 300
can be entered into the scoring file. (Pre-set to 15 for the Evaluation Version).

racers

Fonts:
Font Name. Lucida Sans Typewriter
Font Size – sizes ranging from 7 to 16 pitch can be selected. Size 9 is the default and appears to be most
appropriate to 1024 X 768 resolution monitors
Font Color – select from Black, Gray, Blue, Navy, Teal, Maroon. Default is Navy.
Your screen will change to the selected fonts immediately after clicking “Set”.
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******* Your Suggestions are welcome! *******

For more information contact:
ELB Software
3415 10th St
Winthrop Harbor, IL 60096
email: elb@racelog.com
Internet Site: http://www.racelog.com
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